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SCED Analysis Guide 
SCDA and SCD-effect-sizes Shiny Web Apps 

 

*See Single-case_software table for full overview of analysis techniques capable in each software.  
 
AB-F/U design 
– Example case in Adult mental health outpatient setting (Case Description Three) 
 

Practical task resources 
1. Example Excel dataset with idiographic and nomothetic measures (‘AB-FU_dataset.xlsx’) 
2. Reference papers for the nomothetic measures to inform RCSI analysis.  
3. Single-case-V8 Excel workbook and manual for nomothetic RCSI analysis.  
4. Template PowerPoint with tables etc. to input findings to feedback. 

 

Overview of analysis stages included in guide 
1. Inspect the data 
2. Visual analysis (using time series plots and visual aids) 
3. Assess for trend in the baseline 
4. Statistical analysis (compute non-overlap effect sizes)  
5. Overview of data (phase means & SD) 
6. Repeat stages 2-5 for each idiographic outcome 
7. Reliable and clinically significant change (RCSI) analysis for nomothetic outcomes 
8. Report all the findings  

i. Use PowerPoint template to present results in teaching session  
ii. See the example results for analysis table templates for reporting for your SCED 

assignment 
 
For your assignment data 
See end of the guide for additional tips about how to customise plots from the shiny apps by adding 
phase and axis labels and median trend lines in Microsoft Word (Box 1).  

 Analysis software Link 
Visual SCDA shiny web app https://tamalkd.shinyapps.io/scda/ 
Baseline trend Tau online calculator http://ktarlow.com/stats/tau/ 
Statistical SCD-effect-sizes shiny https://jepusto.shinyapps.io/SCD-effect-sizes/ 
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Step-by-step guide for analysing the data 
 

INSPECT THE DATA 
1. Open the Excel workbook named ‘AB-FU_dataset.xlsx’ and inspect each tab to get an 

understanding of the data. The first tab contains a dataset overview including the design, 
phase lengths and summary of idiographic & nomothetic measures. Data for each 
idiographic measure is included in a separate tab. The final tab contains the nomothetic 
outcomes.  

 
VISUAL ANALYSIS 

2.  To perform the visual analysis, open the 
SCDA Shiny web app using the link 
https://tamalkd.shinyapps.io/scda/. Click 
on the ‘Data’ tab from the menu at the 
top of the page. You will need to upload 
data in Excel file with the data formatted 
in 2 columns – one labelled Phase and 
one labelled Score (the data in the 
example dataset has been formatted in 
the required format).  
 
First, select the ‘Design type’ from the 
drop down menu (e.g. ABA phase design 
to plot 3 separate phases). Click ‘Browse’ 
and locate and open the ‘AB-
FU_dataset.xlsx’. Ensure the ‘File contains 
column headers’ is checked and input the ‘Sheet index number’ for the corresponding tab 
for the first measure in the Excel workbook (i.e., ID1- Relationship is on sheet 2). Ensure the 
A1, B1, A2 ‘Phase labels’ match how they are labelled in the dataset (A, B & F – see 
screenshot) then click ‘Load’. The data should be displayed on the right as shown in the 
screenshot above.  

 
3. Click the ‘Visual Analysis’ tab on the top menu.  In the ‘Plot Observed Data’ panel, ensure 

the ‘Design Type’ and ‘Phase Labels’ are correct. If you want to change/customise the axis 
labels you can input your own into the ‘Axis label’ boxes. Input the minimum and maximum 
value for the scale used for the idiographic measure in the boxes provided and then click 
‘Plot’. A plot of the data will appear on the right hand side.  

 
4. The side-panel menu on the left hand side can be used to produce plots with different visual 

aids, including central tendency lines, trend lines and variability bands. Explore the different 
options (they are all plotted using the same settings as the Observed data plot).  
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5.  Use the ‘Plot Estimate of Trend’ panel to produce a plot with trend lines added for each 
phase. You can choose whether to use Split-middle trend lines or Least Squares regression 
trend lines from the ‘Select the trend visualization’ drop-down box. Right-click on the plot to 
save a copy to your computer or copy and paste into the PowerPoint template.  
 
Note: Before downloading the plot, you can adjust the size by increasing or decreasing the size of 
your browser window. The plot will rescale accordingly. For your SCED assignment, a plot with trend 
lines rather than central tendency levels may be most applicable for the requirements. See Box 1 on 
page 5 for tips on how to customise the plots, such as adding the baseline median trend line or a 
legend. Alternatively see one of the other Analysis Guides for other methods of visually plotting data 
if you would prefer to use a different method in your assignment. 

 
ASSESS BASELINE TREND 

6. To assess the baseline trend, open the Tau online calculator http://ktarlow.com/stats/tau/. 
Copy the A baseline phase scores for an idiographic outcome (i.e., ID1 – relationship from 
the 2nd tab in the Excel dataset) and paste them into the ‘PHASE A (BASELINE)’ box. Copy the 
B intervention phase scores for the same idiographic outcome and paste them into the 
‘PHASE B (TREATMENT)’ box (see screenshot). Click ‘Test for Baseline Trend’.  
 
First, establish whether there is a significant 
baseline trend and record the ‘Baseline 
Trend’ Tau value (e.g. Baseline Trend Tau=-0.040, 

p=0.904). Based on the significance of the 
baseline trend, a ‘Recommended Effect Size’ 
is provided.  
 
Click the relevant option – if Baseline Trend is 
significant (p<0.05), select ‘Baseline 
Corrected Tau’ (will produce TauAvsB – trendA) or 
if Baseline Trend is not significant, select ‘Tau 
(No Baseline Correction)’ (will produce 
TauAvsB). Report the Effect Size displayed for 
the phase A vs B comparison (e.g. 

Recommended effect size: Tau=0.467, p=0.001). 
 
Note: For your assignment, repeat step 6 for each of the idiographic measures you have 
collected and record the results in a table (see e.g. results for example template) 
 
STATISTICAL ANALYSIS 

7. To perform the statistical analysis, open up the SCD-effect-sizes Shiny web app using the link 
https://jepusto.shinyapps.io/SCD-effect-sizes/. Click on the ‘Calculator’ tab from the menu 
at the top of the page. Copy the A baseline phase scores for ID1 – relationship from the 
Excel dataset and paste them into the ‘Phase A’ box. Copy the B intervention phase scores 
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for ID1 – relationship from the Excel dataset and paste them into the ‘Phase B’ box (see 
screenshot below). 
 

8. In the Effect sizes panel, select ‘Non-overlap’. From the drop-down ‘Effect size index’ menu 
select one of the effect sizes. Ensure the ‘Direction of improvement’ is correct for the 
idiographic measure. Can leave the other settings on the defaults.  
 
 NOTE: different idiographic measures for 
the same case may have different 
directions of improvement so ensure the 
correct ‘Direction of improvement’ 
setting is selected based on the direction 
of improvement of each measure – E.g. 
for the example case we want to increase 
the clients relationship quality so the aim 
of the intervention for ID1_relationship is 
increase. However, we want to reduce the 
number of flashbacks so the aim of the 
intervention for ID3_flashbacks will be 
reduce.  

 
The effect size is displayed on the right of the box (e.g. NAP = 0.96). To convert the value to 
a percentage, multiply it by 100. Select and record the effect sizes for at least 3 of the non-
overlap statistics. Tables have been provided in the template PowerPoint to help you 
feedback the results.  
 
Note: The PEM calculation used in this Shiny app adopts a slightly different formula – phase 
B data points that are equal to the phase A median are counted as half a data point 
(Giannakakos & Lanovaz, 2019). 
 
Note: Although Tau and Tau-U are effect size options, there is no accompanying test of 
baseline trend and p value to help determine which metric is most appropriate for the data 
unlike in the Tau online calculator.  
 
By checking the ‘Show graph’ box, a plot will be provided, however it will only plot two 
phases at once (i.e. AB) and does not allow trend lines to be added. By checking the ‘Show 
methods and references’ box, more information about the calculation of the effect size will 
be displayed.  
 
Repeat (if you have time) to obtain between-phase comparison effect sizes for; 
- A and F/U scores (Baseline vs Follow-up) 
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Note: If you have used an AB-FU design for your SCED assignment, also include phase 
comparisons between the baseline (A) and follow-up (FU) phases by repeating steps 2-8 for 
each idiographic measure. See the e.g. results document for an example table template for 
how to report the multiple phase comparison statistics.  

 
DATA OVERVIEW 

9. In the Excel dataset use formulas to compute and report the Mean [=AVERAGE(cell range of 
scores)] and SD [=STDEV(cell range of scores)] for each phase separately.  
 

10. For your assignment, repeat steps 2-9 to produce the visual and statistical analysis for the 
remaining ideographic measures (e.g. ID2 & ID3 in the example). 

 
RCSI ANALYSIS FOR NOMOTHETIC OUTCOMES 

11. To assess whether the client experienced reliable or clinical change on the nomothetic 
outcomes, either use reported reliable change and clinical thresholds for that measure if 
available (e.g. Connell et al, 2007 paper for CORE-OM – the criteria are provided in the first 
tab of AB-FU_datasets.xlsx’).  
 
For your assignment, if reported values are not available for the measure you have used, 
you can calculate the criteria to establish reliable change yourself. Open the Excel workbook 
named ‘single-case-V8.xlsm’. You may need to enable macros in a pop up box. There is an 
accompanying manual for detailed instructions (‘Manual-for-Leeds-RCI-CSC-calculators.pdf’).  

 
On the ‘Data’ tab, input the Pre-baseline and Post-intervention (B) scores from the 
‘Nomothetic Outcomes’ tab in the example dataset where indicated. To calculate reliable 
change, input information about the measure including the lowest & highest possible 
scores, the direction of clinical gain and the reliability of the measure (internal consistency 
Cronbach’s Alpha).You will also need to input the SD for clinical norms in cell C27. This 
information will be available in the psychometric evaluation paper for the measure 
provided.  
 
The box in cell C11 will show whether the client has improved, deteriorated or shown no 
change. In the ‘Results’ tab, cell C17 will show the RCI value – amount of change required to 
be deemed reliable. Repeat for Pre-baseline score to post-intervention (C) score.  
 
If it makes conceptual sense for the measure to have a clinical threshold, you can also 
determine whether CSC is present. If an established clinical cut-off has been determined in 
the psychometric evaluation of the measure, then use this threshold. If not, the Means and 
SDs of clinical & comparison norms can be inputted on the ‘Data’ tab to produce a clinical 
cut-off value (CSC criteria – see manual for more info on which criterion to use).  
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REPORT FINDINGS 
12. Prepare a brief overview of the findings to feedback to the group (e.g., a few PowerPoint 

slides – can use the template provided). Focus on summarising the stages of analysis and 
demonstrating the types of output from the Shiny app (types of visual plots, overlap 
statistics etc.).  
 
Note: For your SCED assignment, see the e.g. results document for a table templates for 
reporting the statistical analysis and examples of how to interpret the effect sizes.  
 
 

 
 
 
 

Box 1: Tips for manually customising plots  
 

Use Word ‘Insert’ and ‘Formatting’ functions to manually customise the plots.  
• Use text boxes to add ‘Baseline’ and ‘Intervention’ labels to phases or a title for the plot if required 

(Insert > Text box). 
• Can also insert text boxes over the axis labels to customize the label to your requirements or to add a 

legend explaining the trend lines etc.. 
• Insert a line to draw the baseline median across all phases or split-middle trend lines in the plot (Insert > 

Illustrations > Shapes > Select line). If you press ‘shift’ when drawing the line it will make sure it is 
horizontal/vertical. Format the shape to change the colour of the line, increase the thickness or make it 
dashed etc.  

• Hold down the ‘shift’ key and select all the added features (text boxes, lines etc.). Without clicking 
anywhere else (so the items all remain selected), right click and select Group > group to combine all the 
added features into one object so they remain in the right place when moving the plot.  

 

See ‘AB-FU_eg_results’ document for an example of the ID1_relationship.  


